Link Plus 

Stand-Alone Probabilistic Record Linkage Software
Linkage Exercises

Contents
1External Linkage Exercise


1About the Data


1Launching Link Plus & Beginning the External Linkage Exercise


2Review of External Linkage Steps


3Step 1:  Select Data Type for File 1


3Step 2:  Locate/Identify File 1


4Step 3:  Data Import for File 1


7Step 4:  Select Data Type for File 2


7Step 5:  Locate/Identify File 2


8Step 6:  Data Import for File 2


10Step 7:  Select Blocking Variables & Phonetic System


11Step 8:  Select Matching Variables & Matching Methods


12Step 9:  Define Missing Values


14Step 10:  Select ID Variables


15Step 11:  Select Direct/EM Method


15Step 12:  Enter Cut-off Value


15Step 13:  Specify Linkage File Name and Location


18Step 14:  Perform Manual Review of Uncertain Matches


22Manual Review Screen Menu Items


24The Datasheet View


24Definition of Class


25Sorting, Hiding, Re-Ordering, Re-Sizing and Re-Formatting Columns


29Customizing the Color Scheme


30Manually Assigning Match Status


30Assigning Match Status Automatically by Score


32Display Uncertain Matches Only


33The Pair View


34Viewing Summary Information


35Using the Search Feature


36Saving and Re-opening Review Sessions


38Independent Manual Review


38Assigning Final Match Statuses


39Step 15:  Export Merged File


40Deduplication Linkage Exercise


40About the Data


40Beginning the Deduplication Exercise


40File Import for Delimited Files


40Opening Previously-saved Linkage Configuration Files


40Review of Deduplication Linkage Steps


40Step 1:  Select Data Type for Data File


40Step 2:  Locate/Identify Data File


40Step 3:  Data Import for Data File


40Step 4:  Select Blocking Variables & Phonetic System


40Step 5:  Select Matching Variables & Matching Methods


40Step 6:  Define Missing Values


40Step 7:  Select ID Variables


40Step 8:  Select Direct/EM Method


40Step 9:  Enter Cut-off Value


40Step 10:  Specify Linkage File Name and Location


40Step 11:  Perform Manual Review of Uncertain Matches


40Hide Record # Column


40Sort by and Manually Reassign Set ID


40Assigning Match Status - Review


40Independent Manual Review


40Assigning Final Match Statuses


40Step 12:  Export Merged File


40Obtaining New Releases of Link Plus



 

External Linkage Exercise
About the Data
Today’s external linkage exercise will involve linking a cancer registry data file with a vital statistics data file.  
Simulated Cancer Registry Records

The data file Registry_File.txt is a fixed width data file containing 50,000 simulated cancer registry records.  
Simulated 2005 Death Data

The data file 2005Death_File.txt is a fixed width data file containing 10,000 simulated death certificate records. 
Linkage Results

One hundred and seventy-eight death certificate records potentially match 178 individuals on the cancer registry data file, and are presented for manual review.  
Launching Link Plus & Beginning the External Linkage Exercise

To launch the Link Plus application and begin today’s exercise complete the following steps:

1. Close all other applications that you may have running.

2. Launch the Link Plus application by clicking on Start…All Programs…Registry Plus…Link Plus…Link Plus.

Result:  The main Link Plus window opens.
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3. Click on the File menu option, and select New Linkage.
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Result:  The Link Plus Linkage Configuration window opens.
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Review of External Linkage Steps

1. Select Data Type for File 1

2. Locate/Identify File 1

3. Data Import for File 1

4. Select Data Type for File 2

5. Locate/Identify File 2

6. Data Import for File 2

7. Select Blocking Variables & Phonetic System

8. Select Matching Variables & Matching Methods

9. Select ID Variables

10. Define Missing Values

11. Select Direct/EM Method

12. Enter Cut-off Value

13. Specify Linkage File Name and Location

14. Perform Manual Review of Uncertain Matches
15. Export Merged File

Step 1:  Select Data Type for File 1

Remember that it makes a difference which of your data files you designate as File 1 and File 2.  File 1 is generally the larger of the two files, as µ probabilities are based on File 1.  At the completion of a linkage run, in addition to the linkage report, Link Plus generates a Non-Match Report, named Non_MatchReport.txt, and stores it in the Report folder of the Link Plus directory.  The report is a tab-delimited text file, and can be opened with a text editor or a spreadsheet program.  

The Non_MatchReport.txt report will contain records from File 2, that, when matched to records in File 1, receive a linkage score below the specified Cut Off Value (i.e., records in File 2 that are definitely not matches to any records in File 1).  

Because our cancer registry file (Registry_File.txt) is the larger of the two files, we will specify it as File 1.
To select the data type for File 1, leave the default value of fixed width selected in the Data Type drop-down menu for File 1.
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Step 2:  Locate/Identify File 1

To locate the Registry_File.txt data file and identify it as File 1, complete the following steps:

1. Click on the folder icon to the right of the input box for File 1.
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Result: The Open Data File dialog box opens.
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2. Click on the Registry_File.txt file, and click Open.

Result:  The Data Import Form for Fixed Width File opens.
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Step 3:  Data Import for File 1
To finish the data import process for File 1, complete these steps:
1. Place the cursor in the in the Data Item column of the first row of the record layout grid.

2. Using the information in the below table, enter the data item name, start position, and length in the record layout grid for each of the variables listed.

	Data Item
	Start Position
	Length

	Record ID
	1
	8

	Last Name
	10
	25

	First Name
	36
	14

	Middle Name
	51
	14

	SSN
	66
	9

	Sex
	76
	1

	Date of Birth
	78
	8

	Street
	87
	40

	City
	128
	30

	State
	159
	2

	Zip
	162
	5

	Race
	168
	2


3. Once you have all of the information entered, click on View Data.

Result:  Link Plus displays the first 20 lines of data in the file, so you can ascertain whether you have the proper positions and lengths for the variables. 
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4. Make sure everything is aligned properly, and then click OK.
Result:  The Save Record Layout File dialog box opens.
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5. In the File name box, enter registry.txt, and click Save.
Result: The registry.txt record layout is saved, and the application returns you to the Linkage Configuration window.
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Step 4:  Select Data Type for File 2
To select the data type for File 2, leave the default value of fixed width selected in the Data Type drop-down menu for File 2.
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Step 5:  Locate/Identify File 2

To locate the 2005Death_File.txt data file and identify it as File 2, complete the following steps:

1. Click on the folder icon to the right of the input box for File 2.
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Result: The Open Data File dialog box opens.
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2. Click on the 2005Death_File.txt file, and click Open.

Result:  The Data Import Form for Fixed Width File opens.
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Step 6:  Data Import for File 2

To finish the data import process for File 2, we will open a record layout file that has been previously saved.  To open a record layout file complete these steps:

1. Click on the folder icon to the right of the Record Layout box.

Result:  The Open Record Layout File dialog box opens.
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2. Double-click on the Configuration folder to open it.

Result:  The Open Record Layout File dialog box opens within the Configuration folder.

3. Click on the 2005Death_Layout.txt record layout.

Result:  The 2005Death_Layout.txt record layout is selected into the File name box.
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4. Click on Open.
Result:  You are returned to the Data Import Form for Fixed Width File window, with the 2005Death_Layout.txt record layout entered automatically in the record layout grid.
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5. Click on View Data.
Result:  Link Plus displays the first 20 lines of data in the 2005Death_File.txt file, so you can verify you have the proper positions and lengths for the variables. 
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6. Click OK.
Result: The 2005Death_Layout.txt record layout is re-saved (in case you needed to make any changes), and the application returns you to the Linkage Configuration window.

Step 7:  Select Blocking Variables & Phonetic System
To select blocking variables and a phonetic system (where applicable), complete these steps:

1. Click on the first empty cell of the grid in the Select blocking variables section.
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Result:  A drop-down menu appears. When clicked, this menu contains all of the variable names of the variables that were specified for the record layout for File 1 (Registry_File.txt ).

[image: image20.png]Select blocking variables Select ID variables (File 1)

| Data Itern (File 1) | Data Itern (File 2) [Phonetic System
o] =l
Record D =
Last Name
First Narme
Middle Name Select ID variables (File 2)
Selelss
oex " [P tem e Matching Method
| |Date ot Birth ata lterm (File 2) atching Metho
Street B
Missing Value (File 1) Missing Value (File 2) ¥ Direct Method ]
CutoffvValue: [
Results will be saved to |
\:\REgF’\us\L\rvkF’\us\rEpnn\LmkagEREpnnb<l Run
L]
| Add Remove Add Remove |

[To team how ta select biocking variables, please click on the help icon in the tool bar





2. Using the drop-down menus for each of the three columns, make the following selections for blocking variables and phonetic systems for File 1 (Registry_File.txt) and File 2 (2005Death_File.txt):

	Data Item (File 1)
	Data Item (File 2)
	Phonetic System

	Last Name 
	Last Name
	NYSIIS

	First Name 
	First Name
	NYSIIS

	SSN
	SSN
	


Step 8:  Select Matching Variables & Matching Methods
To select matching variables and their respective matching methods, complete these steps:

1. Click on the first empty cell of the grid in the Select matching variables and methods section.
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Result:  A drop-down menu appears. When clicked, this menu contains all of the variable names of the variables that were specified for the record layout for File 1 (Registry_File.txt ).
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2. Using the drop-down menus for each of the three columns, make the following selections for matching variables and matching methods for File 1 (Registry_File.txt) and File 2 (2005Death_File.txt):
	Data Item (File 1)
	Data Item (File 2)
	Matching Method

	Date of Birth 
	Date of Birth 
	Date

	Last Name
	Last Name
	Last Name

	First Name
	First Name
	First Name

	SSN
	SSN
	SSN

	Middle Name
	Middle Name
	Middle Name

	Sex
	Sex
	Exact


Step 9:  Define Missing Values
Link Plus automatically treats null or empty values as missing data for Matching Variables and allows the user to indicate additional values which are to be treated as missing data by the program.

To define Missing Values for the matching variables selected, complete these steps:

1. Select the Date of Birth matching variable Variable common to the two files that is used for comparing records by clicking on its row in the matching variables grid.

Result:  The Missing Values and format grid for dates appears.
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Entering Missing Values for date variables works a little differently from other variables.  Missing values are specified separately for each of the date components; day, month, and year.
2. Clicking separately into each cell of the missing value grid, enter the missing values in the following table:
	Date Component
	Missing Value (File 1)
	Missing Value (File 2)

	Day
	99
	99

	Month
	99
	99

	Year
	9999
	9999


3. In addition to specifying Missing Values separately for each of the date components, the date format must also be specified.  Link Plus currently accepts two date formats, MMDDYYYY, and YYYYMMDD.  Both of the data files for today’s linkage exercise have the birth date in the MMDDYYYY format.  
Use the pull-down menu in the format row of the grid to select MMDDYYYY for both File 1 and File 2.
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4. Select the SSN matching variable Variable common to the two files that is used for comparing records by clicking on its row in the matching variables grid.
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5. Click the Add button in the Missing Values grid for File 1.

6. Type 999999999 in the cell and click Add.  Type 000000000 in the new cell that appears.

7. Click the Add button in the Missing Values grid for File 2 at the bottom of the screen.

8. Type 999999999 in the cell and click Add.  Type 000000000 in the new cell that appears.

9. Select the Sex matching variable Variable common to the two files that is used for comparing records by clicking on its row in the matching variables grid.

10. Click the Add button in the Missing Values grid for File 1.

11. Type 9 in the cell that appears.

12. Click the Add button in the Missing Values grid for File 2 at the bottom of the screen.

13. Type 9 in the cell that appears.
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	You can add up to 5 Missing Values.  Missing Values can be deleted by clicking the Remove button.


Step 10:  Select ID Variables
Although the Link Plus linkage report and manual review screen will automatically list the Matching Variables that you have selected, you may want to define other variables to be included in the reports, called ID Variables.  ID Variables, such as Patient ID Number, are variables used for identifying records. Selection of ID Variables is optional.  

To select ID Variables for File 1 and 2 complete these steps:

1. Click in the Select ID variables (File 1) grid, and select the Record ID variable from the drop-down list that appears.
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2. Click in the Select ID variables (File 2) grid, and select the Record ID variable from the drop-down list that appears.
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Step 11:  Select Direct/EM Method
For the purposes of today’s exercise, we will be using the Direct Method to derive the M-Probabilities used in the linkage.  The M-Probability is the probability that a matching variable agrees given that a comparison pair is a match.  When the Direct Method box is clicked, default M-Probabilities are used in the linkage.  Leave the Direct Method box clicked.
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	You can click on Advanced to view the default M-Probabilities or define your own.
Un-click the Direct Method box if you prefer Link Plus to compute the M-Probabilities based on your data using the EM algorithm.


Step 12:  Enter Cut-off Value
Remember that the Cut Off Value is the score value above which comparison pairs are accepted as potential links and presented for manual review.  For the purposes of today’s exercise, enter an initial Cut Off Value of 7 in the Cutoff Value box. 
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Step 13:  Specify Linkage File Name and Location
At the completion of a linkage run, Link Plus will generate a Linkage Report, named LinkageReport.txt, and store it in the Report folder of the Link Plus directory.  The report is a tab-delimited text file, and can be opened with the manual review feature of Link Plus (it also can be opened in a text editor or spreadsheet program). Records are presented in comparison pairs, sorted by their linkage scores in descending order.  Pairs with scores above the selected Cut Off Value are listed. The detail row for each record contains all of the matching and ID variables Variables used for identifying records such as patient ID and record ID. used in the linkage. 
	[image: image32.png]



	Link Plus also generates a non-match report, named Non_MatchReport.txt, which contains records from File 2 not matched to records in File 1 (records receiving a linkage score below the specified Cut Off Value).


You should save the Linkage Report under a new name or it will be over-written the next time you run Link Plus. 

To rename the Linkage Report, complete these steps:
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 to the right of Results will be saved to.
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Result:  The Save linkage results to the file below dialog box opens.
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2. Enter ExternalLink.txt in the File name box, and click Save.
Result: The application returns you to the Linkage Configuration window, where the linkage report name has been changed to ExternalLink.txt.
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3. Click on Save to save the configuration file for this external linkage exercise.
Result: The Save Configuration dialog box opens.
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4. Enter ExternalLink.cfg in the File name box, and click Save.
5. Click Run to run the linkage.
Result: The linkage begins, and the Linkage Process Progress window appears and provides the user with feedback about the linkage process as it is run.  
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The progress window provides feedback regarding the preparation of the configuration, the reading in of the data files, the blocking of the files, and the calculation of the linkage scores. 

When the linkage is complete, the progress window will present the user with the choice of conducting the manual review process directly after the linkage, or closing the progress window, and conducting the manual review process at a later time.

Step 14:  Perform Manual Review of Uncertain Matches
To conduct manual review of the potential matches generated by an external linkage (File 1 with File 2), you must either click on Conduct Manual Review Now in the Linkage Process Progress Window at the completion of the linkage:
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or open the linkage report by clicking on the Manual Review menu item, and click on the New View… option. Either way you open the linkage report, to perform manual review, you will select additional variables for manual review (if desired), and then perform the manual review, assigning a match status to each potential comparison pair. 
1. Click Conduct Manual Review Now.
Result: The Select Additional Fields for Manual Review dialog box opens.
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When performing manual review of potential matches, if you would like to view additional fields other than those already chosen for blocking, matching and ID purposes for the linkage, you can check the boxes on the left and/or right grids for the fields you would like to view. Fields added in this manner will be shown on separate columns on the manual review screen.
2. Click on the box to the left of the Race field name in the Add fields in File 1 grid.
Result:  The Race variable gets added to the center list of Fields for Manual Review, with a _File1 after the field name to indicate that this field comes from File 1.
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However, if you would like two fields, one from File 1, another from File 2, to display on the same column on the manual review screen, you would go to the bottom grid in the center of the window and click on the cells to bring up drop-down lists of fields on the files to select the fields. 
3. In the center panel, in the Field Name (File 1) grid, click in the first empty cell.

Result:  A pull-down menu appears.
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4. Select Street from the pull-down menu.
5. In the center panel, in the Field Name (File 2) grid, click in the first empty cell.

Result:  A pull-down menu appears.

6. Select Street from the pull-down menu for File 2.
7. In a similar fashion, select the fields of City, State, and Zip for both files.
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7. Click on the [image: image44.png]


 button above the grids.

Result:  The fields of Street, City, State, and Zip are added for manual review with the fields from each file to be displayed in the same column for each potential match.
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You can also change the order of fields on the manual review list by clicking on a field and using the small up-arrow and down-arrow to move the field up or down in order.  This is the order in which the columns will be presented for manual review. 
8. Select the Race_File1 field on the Fields for manual review list, and click on the down button until the Race_File1 field is the last field on the list.
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9. Click OK.
Result: The manual review screen opens for the ExternalLink.txt linkage report, with the fields and columns ordered as you specified. 
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Manual Review Screen Menu Items
From the main Manual Review screen, you can access the menu items for the Link Plus manual review process. Click on a menu item option to perform the specified function for the option. The below table describes the menu options on the main Manual Review Screen:

	Menu Item
	Sub-option
	Tool Bar Icon
	Function 

	Manual Review
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	New View…
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	Create a view from a linkage report

	
	Open View…
	
	Open an existing view

	
	Double Review…
	
	Create a view from two views to resolve the differences in assigned match statuses

	
	Restore View
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	Open Link Plus online Help


The Datasheet View
For the manual review of uncertain matches, the default view for comparison pairs is the Datasheet View, where comparison pairs are sorted together and displayed in alternating rows of white and gray colored background.  For each comparison pair, in addition to the variables chosen for matching and manual review, Link Plus generates the following:

	Score/Identifier
	Description

	Score
	For a comparison pair, the overall weight across all matching variables; a higher score means a higher likelihood of being a match

	Class
	Each comparison pair is assigned to a “class” category, which is defined by which matching variables the pair matches exactly on; e.g., Class 1 by default is defined by a perfect match on SSN, Birth Date, First and Last Names

	Link ID
	Unique number assigned to each linked pair

	File
	For a comparison pair, the File number identifies which file (File 1 or File 2 ) the record in the comparison pair originated from 

	Set ID
	For deduplication linkages only - Set ID is a unique number assigned to each group of duplicated records because a record may have multiple duplicates; Set ID may be reassigned after assignment of match status has been completed

	Record #
	Record # is the sequential line (row) number for a record in its data file; e.g., the Record # of the record in the first line of a data file is 1


Definition of Class

Link Plus assigns each comparison pair to a “class” category, defined by which of the matching variables of SSN, Birth Date, First and Last Names that the pair matches exactly on.  For example, Class 1 by default is defined by a perfect match on SSN, Birth Date, First and Last Names.  You may want to sort on Class to sequentially work on groups of similarly matching comparison pairs.
Class category definitions may be viewed by the user.  To view Class definitions, complete these steps:

1. Click on Data from the main menu, and then click on Definition of “Class”…
Result: The Coding for Class dialog box opens.
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2. View the definitions, which use the Y, N, X, and XN coding convention shown.

Within comparison pairs, the record from File 1 is listed first, and the column headers for the variables selected for matching are displayed in a File 1;File 2 format.  In addition, unmatched and missing values for matching variables are highlighted in pink and yellow, respectively.  
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Sorting, Hiding, Re-Ordering, Re-Sizing and Re-Formatting Columns 

The Datasheet View is highly customizable. While working in manual review, individual columns may be sorted, hidden/unhidden from view, and re-sized.  In addition, the order of the columns on the review screen may be modified at any time. 

Sorting Columns

The data within the Datasheet View may be sorted by any individual column, in either of two ways:

1. Right-click on the column to select it.  For today’s exercise, right-click on the Score column. Select the Sort sub-option.
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Result:  The data, originally sorted by ascending score, are sorted in order of descending score.  

2. Select the Score column again, and click on the [image: image66.bmp] icon.
Result:  The data are sorted back in order of ascending score.

Hide-Unhide/Reorder Columns 

To hide, unhide, or re-order columns within the Datasheet View complete these steps:

1. Click on the Data menu item and select the Hide-Unhide/Column-reorder option.
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Result: The Hide-Unhide/Reorder Columns dialog box opens.
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The Hide-Unhide/Reorder Columns dialog box contains two main sections, the Hidden box on the left and the Displayed box on the right.  The Hidden box lists the columns you have selected to hide from view, while the Displayed box lists those that you have selected to view.

The Hide-Unhide/Reorder Columns dialog box enables you to control which columns are displayed for manual review by using the Left and/or Right arrow buttons between the Hidden and Displayed list boxes to move columns between the two lists. 
	[image: image69.png]



	A column may also be hidden from view by right-clicking on the column, and selecting the Hide Column option.


The dialog box also enables you to change the order of the displayed columns.  Select the column name from the list in the Displayed box and use the light blue Up and/or Down arrow buttons to the right of the Displayed list box to move the column up or down in order. 
2. Click on Record #, and then click the left arrow button.
Result:  The Record # column is moved to the list of hidden columns.
3. Click OK.

Result:  Link Plus returns to the main manual review screen, with the Record # column hidden from view.
Re-sizing Columns

To re-size any column on the Datasheet View, left-click and hold on the divider between any two column headers, and pull to the right or left to change the column width. 

Re-formatting Columns

Link Plus allows the user to re-format columns containing dates, phone numbers, Zip code +4 codes, or social security numbers. 
	Format
	Description

	Date (mm/dd/yyyy)
	Re-formats the data in the selected column to MM/DD/YYYY 

	Date (yyyy/mm/dd)
	Re-formats the data in the selected column to YYYY/MM/DD 

	Phone Number
	Re-formats the data in the selected column to (###)###-####

	Zip Code +4
	Re-formats the data in the selected column to #####-####

	Social Security Number
	Re-formats the data in the selected column to ###-##-####


1. Right-click on the SSN;SSN column, select Format, and then select the Social Security Number format. 
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Result:  The data is the column is re-formatted to the specified format.
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2. To restore the data to its original format, right-click on the SSN;SSN column, and select Restore Original Format.
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Result:  The data is the column is re-formatted back to the original format.
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Customizing the Color Scheme 

The default colors for the manual review screen are gray and white for alternating pair rows, pink for unmatched values, and yellow for missing values.  This color scheme is fully-customizable.

To modify the colors for alternating pair rows, unmatched and missing values, complete these steps: 
1. Click on the Tools menu item, and select Options…
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Result:  The Options dialog box opens, with the Manual Review tab selected.
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2. To change any of the colors, select the color you would like to change from the box on the left (1st pair, 2nd pair, unmatched values, missing values) and then select the color of your choice from the color selection box on the right. Select Color for the first pair, and then select the third green box from the top.
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Result:  The Color for the first pair changes from gray to green in the box on the left.

3. Click Apply.

Result:  The color selection has changed on the manual review screen.
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4. Click on the Tools menu item, and select Options…
5. Change the Color for the 1st pair back to medium gray (3rd gray box from top).

6. Click Apply.

Result:  The color selection has changed back to gray on the manual review screen.
Manually Assigning Match Status
Match status can be assigned manually by using the mouse to click in the Match Status check box, or by using the keyboard. 
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Assigning True Match Status:  For the comparison pair being reviewed place the cursor in the Match Status check box and left-click the mouse once, or press the “M” key to select the current pair as a true match and move on to review the next comparison pair. 

Assigning False Match Status:  For the comparison pair being reviewed place the cursor in the Match Status check box and left-click the mouse twice, or press the “N” key to select the current pair as a false match and move on to review the next comparison pair.
Assigning Uncertain Match Status:  For the comparison pair being reviewed place the cursor in the Match Status check box and left-click the mouse three times, or press the “B” key to select the current pair as an uncertain match and move on to review the next comparison pair.
Assigning Match Status Automatically by Score
When a linkage is run, Link Plus saves all potential matches that generated a score above the specified Cut Off Value in the linkage report.  When the linkage report is opened for manual review, all potential matches will be presented for review, even those that generated high scores and are almost certain to be matches, and (depending on the Cut Off Value specified) those that generated low scores and are almost certain to be false matches. With practice, after initial review of the list of comparison pairs it is often easy to identify an upper cut off score above which all pairs are true matches, and a lower cut off score below which all pairs are false matches. The remaining pairs are said to be in the “gray area”; uncertain matches requiring manual review. 

Rather than having to individually assign the match status to each comparison pair manually, Link Plus offers the option to automatically assign match status for groups of pairs by their linkage score.
To assign match status automatically by score, complete these steps:

1. Click on the Data menu item, and select the Assign Match Status… option.
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Result:  The Assign Match Status dialog box opens.
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The Assign Match Status dialog box offers the following options:
	Option
	Description

	Select all as true matches
	Selecting this button will assign a true match status to all comparison pairs in the current view 

	Select all as false matches
	Selecting this button will assign a false match status to all comparison pairs in the current view

	Select all as uncertain matches
	Selecting this button will assign an uncertain match status to all comparison pairs in the current view

	Select true matches by score
	Selecting this button will assign a true match status to all comparison pairs that have a score in the range specified in the from and to boxes

	Select false matches by score
	Selecting this button will assign a false match status to all comparison pairs that have a score in the range specified in the from and to boxes

	Select uncertain matches by score
	Selecting this button will assign an uncertain match status to all comparison pairs that have a score in the range specified in the from and to boxes


2. Click Cancel.

3. Review the comparison pairs, and attempt to identify a match score above which all comparison pairs are true matches.
4. Click on the Data menu item, and select the Assign Match Status… option.
5. Click on Select true matches by score from, enter the upper score you have identified in the first box, enter 100 in the second box, and then click OK.
Result:  The manual review screen re-opens with the specified match statuses assigned.
Display Uncertain Matches Only
While performing manual review, some users may prefer to view only the uncertain matches, and have those pairs that have been assigned a match status of true and false hidden from view.
The manual review screen can be restricted to display only uncertain matches in two different ways: 

1. Click on the Data menu item, and select the Display Uncertain Match Only option.
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Result:  Only uncertain matches will be displayed for review, and those pairs that have been assigned a match status of true and false are hidden from view.

2. Click on the Display Only Uncertain Matches icon [image: image82.png]kplus\VbDemo\report\workingview. default]
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 on the tool bar.

You can return to a view that displays all matches in two different ways as well:

1. Click on the Data menu item, and select the Display All option.
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Result:  All matches will be displayed for review, regardless of match status.

2. Click on the Display All Matches icon [image: image84.bmp] on the tool bar.

The Pair View

While performing manual review, some users may prefer to view the comparison pairs individually rather than within the Datasheet View.  For these users, Links Plus offers the Pair View, which provides a side-by-side comparison of the two records being currently reviewed. 
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When working in the Pair View, match status can be assigned by using the mouse to click in the Match Status check box, or by using the keyboard.
Assigning True Match Status:  Place the cursor in the Match Status check box and left-click the mouse once, or press the “M” key to select the current pair as a true match. 

Assigning False Match Status:  Place the cursor in the Match Status check box and left-click the mouse twice, or press the “N” key to select the current pair as a false match.

Assigning Uncertain Match Status:  Place the cursor in the Match Status check box and left-click the mouse three times, or press the “B” key to select the current pair as an uncertain match.

You can navigate between comparison pairs in the Pair View by clicking the Back and Next buttons. 

You can open the Pair View for a comparison pair in four different ways.  With the current record selected in the Datasheet View:

1. Click on the Pair View Icon [image: image87.png]kplus\VbDemo\report\workingview. default]
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 on the tool bar.

2. Right-click anywhere on the manual review screen, and select the Pair View…option.
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3. Click on the Data menu item, and select the Pair View… option.
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4. Press the F2 key.

5. Regardless of the way you opened the Pair View, for now, click Cancel to return to the Datasheet View.

Viewing Summary Information

Over the course of the manual review process, and upon its completion, you may want to view summary information regarding the total number of comparison pairs, true matches, false matches, and uncertain matches (as well as these totals for the pairs that are displayed) for the current review session.  Link Plus keeps track of this summary-level information, and displays it upon command. 
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Summary information may be viewed in two different ways:

1. Click on the Data menu item, and select the Summary option.
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2. Click on the Summary icon [image: image92.png]=181]

Manual Review Data_Help

CIEIE = EIRdEANS
7= true matches lse matches ] = uncertain matches = unmatched values issing valles
|Score = |Class |Link ID |File |Record # | LNAME; Name-La| FNAME; Name-Fi| DOB;Birth Dat | SSN;Social Security Nun| Mi;Name--Middl| SEX,Sex | RACE;Race 1|DT 4|

T 1 146 MOOTRY DELMA 07201931 BO14Z6167 R 2 T (o
L1215 41 2 25m  MOOTRY DELMA 07201931 801426167 R 2 1

4 2 168 MALONE PEARLINE 04011920 804827393 J 2 1 [
215 4 2 2 3B02  MALONE PEARLINE 04011920 804827393 J 2 1

4 3 18 MAHAFFEY  AIMEE 0031922 BO3326262 P 2 1 [
L1215 4 3 2 4502 MAHAFFEY  AMEE 031922 80336262 P 2 1

44 12 TRIANA SAMANTHA  DE211921 813125345 F 2 1 [
215 44 210502 TRIANA SAMANTHA  DS211921 813125345 F 2 1

4 5 17 HISER BRIDGET 08261959 9BADE26E8 w 2 1 [
L1215 4 5 2 3812 HISER BRIDGET 08261959 9BADE26EB w 2 1

4 B 1% ROKISKY FELX 12111929 800125092 E 1 2 [
215 4 B 212002 ROKISKY FELIX 12111929 800125092 E 1 2

47 147 SEMPER BERNICE 05241915 634327209 v 2 1 [
L1215 47 2 2002 SEMPER BERNICE 05241915 834327209 v 2 1

4 8 1o TRIMARCHI  JUDITH 01111930 627228518 A 2 1 [
211 4 8 2 3002 TRIMARCH  JUDITH 01111930 827228518 A 2 1

49 (- SCRUGGS CANDACE 01231948 826427688 L 2 1 [
L1210 4 3 2 30002 SCRUGGS CANDACE 01231948 826427688 LINDA 2 1

4 0 1 B KULLA IMMIE 1M2\I91E BA27122 T 1 1 [
210 410 2 31002 KULLA IMMIE 1261918 804127122 TERRELL 1 1

4 1 1 SENG JULES 11191945 BE2628726 v 1 1 [
L1210 41 2 2902 SENG JULES 11191945 BE2628726 VAZQUEZ 1 1

4 12 1 s SMALL CLYDE 08231911 804726214 s 1 1 [
210 412 2 2002 SMALL CLYDE 08231911 804726214 STERWALT 1 1

4 13 1 om AMIN ANGELINA 02131935 900E29249 H 2 1 [
L1210 413 2 2302 AMN ANGELINA 02131935 900E29249 HARPER 2 1

4 141 BARTON LORA 0281948 BDBE25247 F 2 1 [
210 4 14 2 11502 BARTON LORA 0281948 BOBE25247 FRANCE 2 1

4 15 1 @™ CHESNUTT CLFTON 08271950 BO4B25470 M 1 1 [
L1210 4 15 2 14502 CHESNUTT CLFTON 08271950 BOAB25470 MCGOUGH 1 1

4 B 1| MOURER BRUCE 09151940 922630012 N 1 1 [
210 4 16 2 24502 MOURER BRUCE 09151940 920630012 N 1 1
KN

start| | 5] Link Pus Training Linkage. . | [ Micrasoft Powerpoint - [L...| &1 vahoo! Mai - kkthoburn..._|[ 4 Link Plus - [Linkage R. Inbox - Microsoft outioo. | [« [2]:3@ vioapm




 on the tool bar.

3. View the summary information and click Close.

Using the Search Feature 

During the manual review process, you may want to find a word within one of the data columns.  Link Plus provides a search feature that allows you to do so.
The manual review search feature can be opened in three different ways:
1. Click on the Data menu item, and select the Find option.
[image: image93.png]Data Tooks Help
‘Assign Metch status.
Defintian of 'Class".

Display Al
Display Uncertain Match Orly.

Hide-Linhide/Colurmr Remdevg




2. Click on the Find icon [image: image94.png]kplus\VbDemo\report\workingview. default]
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 on the tool bar.
3. Press Ctrl+F on the keyboard.

Result: The Find dialog box opens.
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4. Enter the word JACOBS in the Find what box.  
5. Select the Last Name;Last Name column from the pull-down list.
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6. Select the Down search direction button, and click Find Next.

Result: Link Plus highlights the first occurrence in the down direction of the search term JACOBS in the Last Name;Last Name column. 
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7. Click Cancel.

Saving and Re-opening Review Sessions

Any review session may be saved as a .view file, and re-opened to at a later time.  It is recommended that you save the view periodically throughout the manual review process, and upon completion of review, to save your match status assignments.  

To save this review session, complete these steps:
1. Click on the Manual Review menu item and select the Save View As… option.
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Result:  The Save View dialog box opens.
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2. Enter NewViewName.view in the File name box.

3. Click Save.

To re-open a saved review session, complete these steps:

1. Click on the Manual Review menu item and select the Open View option.
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Result:  The Open Linkage View File dialog box opens.
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2. Click on the NewViewName.view file and click Open.

Result:  The manual review screen opens with the linkage view displayed. 

Independent Manual Review

Using the information you have just learned about the manual review screen, take some time and resolve a few matches on your own, making sure to view the summary information at least once.  
Feel free to modify the screen layout as desired – re-order, re-size or hide columns, change the color scheme, or view the comparison pairs in Datasheet or Pair View.  Take note of comparison pairs with Link IDs of 83 and 93 to see examples of how the Link Plus First Name Matching Method links records with nicknames and full names. 
Assigning Final Match Statuses
To assign the final match statuses for today’s external linkage exercise automatically by score, complete these steps:

1. Click on the Data menu item, and select the Assign Match Status… option.
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Result:  The Assign Match Status dialog box opens.
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2. Click on Select true matches by score from, enter 13.3 in the first box, enter 100 in the second box, and then click OK.

Result:  The manual review screen re-opens with the specified match statuses assigned.

3. Click on the Data menu item again, and select the Assign Match Status… option a second time.
Result:  The Assign Match Status dialog box opens.
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4. Click on Select false matches by score from, enter 0 in the first box, enter 12.4 in the second box, and then click OK.

Result:  The manual review screen re-opens with the specified match statuses assigned.

Step 15:  Export Merged File

Once you have completed your manual review of the potential matches presented for review, and have assigned a match status to them (either manually by clicking, or via the Data…Assign Match Status option), you will want to export a merged file.  Link Plus offers the export of the merged file in a text file in delimited file format, and allows you to specify what file delimiter you would like to use, and what match status(es) you would like to export.

To set the export file format option and export a merged file, complete these steps:

1. Click on the Tools menu item, and select Options…
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Result:  The Options dialog box opens, with the Manual Review tab selected.
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2. Click on the Export tab.

Result:  The Export Options dialog box opens.
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3. To set the export file format option to comma-delimited, click on Comma.
4. Unclick the Uncertain Match and False Match under Include, and then click OK.

Result:  The export file format has now been set to a comma-delimited file format, and when the data are exported, only records assigned a match status of true will be exported.
5. To export the file, click on the Data menu item, and click on Export…
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Result:  The Export Setting dialog box opens.
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5. Select the fields from File 1 and File 2 that you would like in your merged export file by clicking the box in the column to the left of the data field.  Click the fields in the order in which you would like them listed in the export file.
6. Click on the Export button.

Result:  A window opens where you can specify a name for the exported merged file, and location on your PC or on a shared network folder where you would like to save the file. The default location for exported files within Link Plus is the C:/RegPlus/LinkPlus/Export folder.
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7. In the File name box, type External1.txt, and click the Save button.

Result: A comma-delimited merged file (named External1.txt) of records with true match status, with the data fields you selected (in the order you selected them) is generated and placed in the C:/RegPlus/LinkPlus/Export folder.  In addition, Notepad will open with a view of the merged file.
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	If you are having trouble viewing the information in this file, you can adjust the font size and turn off the Word Wrap option under the Format menu in Notepad.

This file can be easily imported into Microsoft Excel.


1. Close out of Notepad and click Cancel on the Export Setting dialog box to return to the manual review screen.

2. Click on the Manual Review menu item, and select the Close View option.
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Result:  The main Link Plus window opens.
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Deduplication Linkage Exercise
About the Data
Today’s deduplication linkage exercise will involve linking a cancer registry data file to itself in order to identify duplicate records.  
Simulated Cancer Registry Records

The data file dupdelimdemofile.txt is a tab-delimited data file containing 99,202 simulated cancer registry patient records.  
Linkage Results

158 records on the cancer registry data file potentially match themselves and are potential duplicates; these records are presented for manual review.  
Beginning the Deduplication Exercise

Our external linkage exercise involved linking two fixed width files together.  For today’s deduplication linkage exercise, we will be linking a tab-delimited file to itself.  The steps required to configure a linkage for delimited files is the same for those for fixed width files, with the exception of the file import process.  Within the file import process, the assignment of variable names is slightly different.  Rather than entering the variable names and positions, you first specify the file delimiter, and then assign the variable names from pull-down menus.

File Import for Delimited Files
To become familiar with the import process for delimited files, complete these steps: 
1. Click on the File menu option, select New Deduplication, and select Delimited File.
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Result:  The Link Plus Deduplicating Configuration window opens.
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2. Click on the folder icon to the right of the Data File input box.
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Result: The Open Data File dialog box opens.
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3. Click on the dupdelimdemofile.txt file, and click the Open button.

Result:  The Data Import Form for Delimited File opens.
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4. The data file, dupdelimdemofile.txt is a tab-delimited file; click on Tab, and then click View Data.

Result:  The data are displayed correctly in their proper columns, but without variable names.
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5. Click on the column header of the second column.

Result: A pull-down menu appears.
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6. Select Name—Last from the pull-down menu to label the second column.
7. Click on the column header of the third column, and select Name—Middle from the pull-down menu to label the third column.
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You would continue to label columns in this manner until all of the desired columns are labeled, and then click on OK.  Link Plus would then return to the Link Plus Deduplicating Configuration window, where you would complete the linkage configuration.

8. Click Cancel.

Opening Previously-saved Linkage Configuration Files

Often Link Plus users need to run the same linkage multiple times, with minor variations in the linkage configuration, such as different data files or Cut Off Values.  As you saw in today’s external linkage exercise, Link Plus allows the user to save a linkage configuration file, so it may be opened and used again at a later time (with or with out modifications to the configuration).
For today’s deduplication linkage exercise, we will be opening a previously-saved linkage configuration file, called DupDelimDemo.cfg.  To open this configuration file, complete the following steps:

1. Click on the File menu option, and select Open Configuration File…
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Result:  The Open Configuration File dialog box opens.
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2. Click on the DupDelimDemo.cfg file, and click the Open button.

Result:  The Deduplication Configuration window opens, with the previously-saved parameters for the linkage specified.  
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Review of Deduplication Linkage Steps

1. Select Data Type for Data File 

2. Locate/Identify Data File 

3. Data Import for Data File 

4. Select Blocking Variables & Phonetic System

5. Select Matching Variables & Matching Methods

6. Select ID Variables

7. Define Missing Values

8. Select Direct/EM Method

9. Enter Cut-off Value

10. Specify Linkage File Name and Location

11. Perform Manual Review of Uncertain Matches
12. Export Merged File

Step 1:  Select Data Type for Data File 

As you have just seen, when you select a new deduplication linkage from the file menu, you specify the data type for the file at the same time.  The linkage configuration that we opened, DupDelimDemo.cfg, has the data type of delimited previously specified, so at this point Link Plus knows the data type is tab-delimited.  
Step 2:  Locate/Identify Data File
For deduplication linkages, only one data file is selected.  The data file specified for the DupDelimDemo.cfg linkage configuration file is the same dupdelimdemofile.txt file that we just practiced labeling the column headers on, and has already been identified for the configuration.  
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Step 3:  Data Import for Data File
All of the desired data column headers have been labeled for the tab-delimited dupdelimdemofile.txt data file, and saved with the linkage configuration. To view or modify the data column labels saved for the DupDelimDemo.cfg configuration, complete these steps:

1. Click on the folder icon to the right of the Data File input box.
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Result: The Open Data File dialog box opens.
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2. Click on the dupdelimdemofile.txt file, and click the Open button.

Result:  The Data Import Form for Delimited File opens.  Note that tab-delimited is specified, and that all of the columns of data to be used in the linkage are labeled.
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3. Click on OK.

Result: The application returns you to the Deduplicating Configuration window.

Step 4:  Select Blocking Variables & Phonetic System
Blocking variables and respective phonetic systems (where applicable) are also saved in linkage configuration files.  Using the drop-down menus for the Data Item and Phonetic System columns, the following blocking variables and phonetic systems have been specified for the DupDelimDemo.cfg linkage:
	Data Item 
	Phonetic System

	Name--Last
	Soundex

	Social Security Number
	

	Birth Date
	

	Name--First
	Soundex


Step 5:  Select Matching Variables & Matching Methods
Matching variables and respective Matching Methods are saved in linkage configuration files.  Using the drop-down menus for the Data Item and Matching Method columns, the following matching variables and Matching Methods have been specified for the DupDelimDemo.cfg linkage:
	Data Item 
	Matching Method

	Name--First
	First Name

	Name--Last
	Last Name

	Name—Middle
	Middle Name

	Race1
	Value-specific

	Sex
	Exact

	Birth Date
	Date

	Social Security Number
	SSN


Step 6:  Define Missing Values
Missing Values and date formats are saved in linkage configuration files. Remember that Missing Values and date formats are specified by clicking on the row of a matching variable in the matching variables grid, clicking the Add button below the Missing Values grid, and entering the values in the grid.  You can add up to 5 Missing Values.  Missing values can be deleted by clicking the Remove button.  The following Missing Values were specified for the DupDelimDemo.cfg configuration:
	Matching Variable
	Missing Value 

	Name--First
	

	Name--Last
	

	Name—Middle
	

	Race1
	99

	Sex
	9

	Birth Date
	Day=99, Month=99, Year=9999, YYYYMMDDD format

	Social Security Number
	999999999


Step 7:  Select ID Variables
Although Link Plus reports will automatically include Matching Variables, you may want to define other variables to be included in the reports, called ID Variables.  Recall that ID Variables, such as Patient ID Number (selected for today’s exercise), are variables used for identifying records.  Selection of ID Variables is optional.  

To select ID Variables for the data file, you would click in the Select ID variables grid, and select the desired variable(s) from the drop-down list that appears.

Step 8:  Select Direct/EM Method
For the purposes of today’s deduplication linkage exercise, we will be using the Direct Method to derive the M-Probabilities used in the linkage.  The M-Probability is the probability that a matching variable agrees given that a comparison pair is a match.  When the Direct Method box is clicked, default M-Probabilities are used in the linkage.  Leave the Direct Method box clicked.
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	You can click on Advanced to view the default M-Probabilities or define your own.
Un-click the Direct Method box if you prefer Link Plus to compute the M-Probabilities based on your data using the EM algorithm.


Step 9:  Enter Cut-off Value
Remember that the Cut Off Value is the score value above which comparison pairs are accepted as potential links and presented for manual review.  For the purposes of today’s deduplication linkage exercise, a Cut Off Value of 10 has been specified. 
                                              [image: image132.png]Cunffvalue — [10



 

Step 10:  Specify Linkage File Name and Location
At the completion of a deduplication linkage run, Link Plus will generate a Linkage Report, named LinkageReport.txt, and store it in the Report folder of the Link Plus directory.  The report is a tab-delimited text file, and can be opened with the manual review feature of Link Plus (it also can be opened in a text editor or spreadsheet program). Records are presented in comparison pairs, sorted by their linkage scores in descending order.  Pairs with scores above the selected cut off value are listed. The detail row for each record contains all of the matching and ID variables Variables used for identifying records such as patient ID and record ID. used in the linkage. 

You will need to rename the linkage report or it will be over-written the next time you run Link Plus. 

To rename the Linkage Report, complete these steps:
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 to the right of Results will be saved to.
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Result:  The Save linkage results to the file below dialog box opens.
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2. Enter DedupLink.txt in the File name box, and click Save.
Result: The application returns you to the Deduplicating Configuration window, where the linkage report name has been changed to DedupLink.txt.
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3. Click on Save to save the configuration file for this deduplication linkage exercise.
Result: The Save Configuration dialog box opens.
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4. Enter DedupLink.cfg in the File name box, and click Save.
Result:  The application returns to the Deduplicating Configuration window, with a message that the changes to the configuration file have been saved in the DupDelimDemo.cfg file.
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5. Click Run to run the linkage.
Result: The linkage begins, and the Linkage Process Progress window appears and provides the user with feedback about the linkage process as it is run.  
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The progress window provides feedback regarding the preparation of the configuration, the reading in of the data files, the blocking of the files, and the calculation of the linkage scores. 

When the linkage is complete, the progress window will present the user with the choice of conducting the manual review process directly after the linkage, or closing the progress window, and conducting the manual review process at a later time.

Step 11:  Perform Manual Review of Uncertain Matches
To conduct manual review of the potential matches generated by a deduplication linkage, you must either click on Conduct Manual Review Now in the Linkage Process Progress Window at the completion of the linkage:
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or open the linkage report by clicking on the Manual Review menu item, and click on the New View… option. Either way you open the linkage report, to perform manual review, you will select additional variables for manual review (if desired), and then perform the manual review, assigning a match status to each potential comparison pair. 
1. Click Conduct Manual Review Now.

Result: The Select Additional Fields for Manual Review dialog box opens.

[image: image141.png]Select Additional Fields For Manual Review'

[CARegPlus\LinkPlus\data\dupdelimdemofie. i

Field Name

Fields for manual review
Patient ID Number

Social Security Number

UK E ] Cancel





When performing manual review of potential duplicate records, if you would like to view additional fields other than those already chosen for blocking, matching, and ID purposes for the linkage, you can check the boxes on the left grid for the fields you would like to view, and click OK. 

Note that for today’s deduplication linkage exercise, all available fields were used for blocking, matching, or ID purposes, so there are no additional fields to be added to the report.

2. Click OK.

Result: The manual review screen opens for the DedupLink.txt linkage report. 
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[ 414 186 152 99170 9000072 NELLA SUTTIE EUNICE 0 2 19720509 3B0000620
17 151 99039 9000041 TRUDY ENDERS F o 2 19E0127 DO0AN718
[ 41.4 17 161 99139 90DDOGA1 TRUDY ENDERS F o 2 19E0127 DOOI71E8
18 160 99053 90DDDSES MAY STILL ROSEMARY 01 2 19530612 BOODDO917
[ 414 18 150 99153 90DOOGSS MAY STILL ROSEMARY 01 2 19530612 B00DDD917
1s 149 99073 90DDSTS MELONE  PURPLE CHAVIS 02 19571114 137003031
L1413 108 143 99194 90DO0GI6 MELONE  PURPLE CHAVIS o2 19571114 137003031
110 148 99043 9000DSHS MARIA DEARDEN MARIORIE 01 2 19260815 207005326
0413 110 148 99143 90000B45 MARIA DEARDEN MARJORIE 01 2 19260615 207005326
111 147 99065 9000057 FLOSSIE  CATCHINGS  NOEL 0 2 19930303 359009629
L1413 1 1 147 99185 90000667 FLOSSIE  CATCHINGS  NOEL 0 2 19930303 359009629
112 146 99067  9000DSES BEULAH  LANCON T 0 2 19390614 907002128
0413 112 146 99167 90000869 BEULAH  LANCON T 0 2 19390614 907002128
113 145 99094 900005% DANIELA  DREES SUELLEN 01 2 19040301 152001975
L1413 113 145 99182 90000684 DANELA  DREES SUELLEN 01 2 19040301 152001975
1 14 144 99099 S00DDAOT CHAROLETTE LANDROTH W 0 2 19350224 B20008B17
0412 1 14 144 99191 90000693 CHAROLETTE LANDROTH W 01 2 19350224 B20008B17
115 85 9u092 90000534 LiDA SELLON IELMA 0 2 19010918 DOOG71446
L1412 1 15 85 99195 90000698 LiDA SELLON ZELMA 0 2 19010918 DOOG71446
116 142 99015 90000517 ORAL HAWS NOONKESTEFO1 1 19930306 000072436
[ 411 1 16 142 93117 90000619 ORAL HAWS NOONKESTEFO1 1 19930306 000072435
117 141 99050 90000sB! EVAN PLAXTON MOISES 01 1 19220511 386005499





You can fully customize the manual review screen for deduplication linkages, and perform all of the same functions that we learned about earlier when performing the manual review for the external linkage exercise: 

· Individual columns may be sorted, hidden/unhidden from view, and re-sized
· The order and format of the columns on the review screen may be modified
· The color scheme may be modified

· Match status can be assigned both manually and automatically by match score 

· The list of comparison pairs can be restricted to display uncertain matches only

· You can choose between the Datasheet View and the Pair View
· You can view and modify the coding for the Class variable

· You can view summary information for the manual review process 

· You can use the search feature
· You can save and re-open views
As for external linkages, the default view for the manual review of uncertain matches is the Datasheet View, where comparison pairs are sorted together and displayed in alternating rows of white and gray colored background.  In addition, unmatched and missing values for matching variables are highlighted in pink and yellow, respectively.

From the main Manual Review screen, you can access all of the same menu items for the Link Plus manual review process as those for the external linkage we performed earlier, plus one additional option. For manual review of deduplication linkages, Link Plus generates one additional identifier called a Set ID.  The Set ID is a unique number assigned to each group of duplicated records because a record may have multiple duplicates.  The Set ID may be manually re-assigned. 
Prior to performing the manual review of uncertain matches, we will first hide the column of Record #, and learn a little more about the Set ID.

Hide Record # Column

To hide the column of Record #, complete these steps:

1. Click on the Data menu item and select the Hide-Unhide/Column-reorder option.

Result: The Hide-unhide/Reorder Columns dialog box opens.
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Select the Record # variable from the Displayed list, and click on the left arrow button to move it over to the Hidden list. 
Result:  The Record # column is moved to the list of hidden columns.
	[image: image144.png]



	Remember, a column may also be hidden from view by right-clicking on the column in the Datasheet View, and selecting the Hide Column option.


2. Click OK.

Result:  Link Plus returns to the main manual review screen, with the Record # column hidden from view.

[image: image145.png]=181]

=18 x|
7= true matches lse matches || = uncertain matches = unmatched values = missing values,
|_|Sgote. ] Class |Link ID | Set ID |Patient ID Number | Name-First | Name-Last | Name--Middle |Race 1 |Sex | Birth Date | Social Security Numi| &
1 167 90000550 JAMARCUS RUDACILLE W2 1 19771113 178007027 H
[l 432 11 167 90000850 JAMARCUS ~ RUDACILLE T 021 19771113 178007027
12 156 9000DBOD BENITO DEVRIES w 02 1 19080801 DDO713B16
432 12 155 9000DBE2 BENITO DEVRIES w 02 1 19080BD1 DDO713616
103 155 90000597 JAKOB BUSHONG B o1 19411127 829005327
L1419 103 165 9000DG76 JAKOB BUSHONG B o1 19411127 829005327
[t 154 90000598 WAYLAND  DOPSON 98 1 19000305 39700BE51
0418 14 154 90000833 WAYLAND  DOPSON 98 1 19000305 39700BE1
15 163 90000538 FORREST  LANKFORD 97 1 19780105 736003244
[l 47 105 163 90000638 FORREST  LANKFORD 97 1 19780105 736003244
[ 162 90000572 NELLA SUTTEE EUNICE 0 2 19720509 3B0000620
[ 414 186 152 90000672 NELLA SUTTIE EUNICE 0 2 19720509 3B0000620
17 151 90000541 TRUDY ENDERS F o 2 19E0127 DO0AN718
[ 41.4 17 151 90000641 TRUDY ENDERS F o 2 19E0127 DOOI71E8
18 160 90000555 MAY STILL ROSEMARY 01 2 19530612 BOODDO917
[ 414 18 150 90000855 MAY STILL ROSEMARY 01 2 19530612 B00DDD917
1s 149 90000575 MELONE  PURPLE CHAVIS 02 19571114 137003031
L1413 108 143 9000069 MELONE  PURPLE CHAVIS o2 19571114 137003031
110 148 90000545 MARIA DEARDEN MARIORIE 01 2 19260815 207005326
0413 110 148 90000645 MARIA DEARDEN MARJORIE 01 2 19260615 207005326
11 147 o0000sE7 FLOSSIE  CATCHINGS  NOEL 0 2 19930303 359009629
L1413 1M 147 90000667 FLOSSIE  CATCHINGS  NOEL 0 2 19930303 359009629
112 146 9000059 BEULAH  LANCON T 0 2 19390614 907002128
0413 112 145 90000GES BEULAH  LANCON T 0 2 19390614 907002128
113 145 o00005% DANIELA  DREES SUELLEN 01 2 19040301 152001975
L1413 113 145 90000GR4 DANELA  DREES SUELLEN 01 2 19040301 152001975
114 144 90000BDI CHAROLETTE LANDROTH W 0 2 19350224 B20008B17
0412 114 144 900006S3 CHAROLETTE LANDROTH W 01 2 19350224 B20008B17
115 85 on0osw LiDA SELLON IELMA 0 2 19010918 DOOG71446
L1412 1 15 85 900006%8 LiDA SELLON ZELMA 0 2 19010918 DOOG71446
116 142 90000517 ORAL HAWS NOONKESTEFO1 1 19930306 000072436
[ 411 116 142 90000613 ORAL HAWS NOONKESTEFO1 1 19930306 000072435
17 141 on00osel EVAN PLAXTON MOISES 01 1 19220511 386005499





Sort by and Manually Reassign Set ID

Set ID is generated only for deduplication linkages, and is a unique number assigned to each group of duplicated records because a record may have multiple duplicates, and generate multiple comparison pairs.  If the data are sorted by the Set ID, then all of the potential comparison pairs for a single individual may be manually reviewed together. The Set ID may be manually reassigned after assignment of match status. 

The dupdelimdemofile.txt data file contains one record with potential multiple duplicates; the comparison pairs for this record have been assigned a Set ID of 52.  Scroll through the list until you find the Link ID of 78; this is the first of three comparison pairs that have been assigned a Set ID of 52. 

[image: image146.png]__|Score  <|Class |Link ID |Set ID | Patient ID Number |Name--First |Name--Last |Name--Middle |Race 1 |Sex |Birth Date|Social Security Numi

T 78 52 00377 OLA VALADE OTTILE o 2 19430105 541003005
1341 4 78 5 1003377 oLA VALADE OTTILE i} 2 19439999 541003005
4 79 79 90000503 RUBIE HUNTING COLQUHOUN 01 2 19380115 247000637
L1310 4 79 79 90000605 RUBIE HUNTING COLQUHOUN 01 2 19389999 247000537
11 80 78 90000526 DONOVAN  HUTCH 20 1 19421004 002000373
[1330 11 B0 78 90000628 DONOVAN  HUTCH 20 1 19421004 002000873
4 81 77 90000504 RAPHAEL ~ VANDOVER  BRYSON 01 1 19840320 9EBODSI2E
Lli=27 4 81 77 90000606 RAPHAEL ~ VANDOVER  BRYSON 01 1 19840420 9BEDDEI2E
1 82 76 90000522 DELMA MOLLOY CORLEY 01 2 19780513 111000158
[1326 11 82 75 9000024 DELMA MOLLOY CORLEY 01 2 19780513 114000158
4 8 75 90000507 CAYLA GONZALEZ ~ HAWSE o 2 19130306 276004557
Llis20 4 8 75 90000609 CAYLA GONZALEZ ~ HAWSE o 2 99999999 276004557
1 84 74  90000s08 VON BUNDICK 02 1 19721221 056003967
[1319 1 B4 74 90000610 VON BUNDICK 02 2 19721221 056003967
4 8 73 90000505 GLYNN THOMASSON ~ STENBACH 02 1 19411213 442008063
L1308 4 85 73 90000607 GLYNN THOMASSON ~ STENBACH 02 1 19411222 442008063
2 8 72 90000512 MARGARITA  GULLIFER z il 2 19560123 707004658
[1307 2 8 72 9000014 MARGERY  GULLIFER z i} 2 19560123 707004658
6 & 71 90000519 BART HOLLENBECK DOMINICK 01 1 19880704 4BB005E90
Lli=0s 6 & 71 90000621 BART HOLLENBECK ~DOMINICK D1 1 19880704 999999999
8 8 70 90000576 GEARY METZ c il 1 19900317 90BDO0344
[1304 § 8 70 90000637 GEARY MET'Z c i} 1 19900317 999999999
3 89 69 90000588 A WYKOFF o 1 19591004 4BBD07E37
%n 3 3 8 63 90000588 A WYKOF il 1 19591004 4BBDO7EI7
4 90 68 90000506 DELPHINE  STEIGER DOROTHY 01 2 19291116 494001045
[1293 4 90 68 90000608 DELPHINE  STEIGER DOROTHY 01 2 19371116 494001045
191 b7 90000529 GINA MCELROYS  KEYS 02 2 19190410 914000956
L2 191 B7  90000B3! GINA MCELROYS  KEYS 02 2 19190410 271828182
1 92 BB 90000S3t DARRON  DOWDELL NOLAND 02 1 19520425 20007976
[1290 11 92 BB 90000633 DARRON  DOWDELL NOLAND 02 1 19520425 000000000
1193 B5 90000523 ALEXUS STEWARD ELIZA o 2 19400210 935002465
Lliz2 1193 B5 90000625 ALEXUS STEWARD ELIZA o 2 19400210 935602465
7 94 64 90000585 SHERRON  STETLER DENSON 02 2 19930428 (48003203




To see all three of the comparison pairs assigned the Set ID of 52:

1. Sort the list of comparison pairs by Set ID in ascending order by right-clicking on the column of Set ID, and then selecting the Sort option.
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2. Scroll through the list until you locate Set ID 52. 
[image: image148.png][¥1= true matches. false matches || = uncertain matches = unmatched values = missing values
_|score |Class |Link ID | Set 1B | Patient ID Number | Name-First | Name--Last | Name--Middle |Race 1 |Sex | Birth Date | Social Security Numi|
4 78 &2 100377 OLA VALADE OTTILE O 2 19430105 541003006
[ 341 4 78 52 10033577 oA VALADE OTTILE 00 2 19439999 541003005
9 15 52 10053230 oLA VALADE 0 2 19540611 999999999
[ 133 9 15 52 10033577 oLA VALADE OTTILE 01 2 19439999 541003005
9 B 52 1003377 oLA VALADE OTTILE O 2 19430105 541003005
L1139 9 16 52 10053230 oA VALADE 0 2 19540611 999999999
14 104 54 10054766 THEADORE  STUCKER € o1 19410314 022001023
[ 14.1 14104 54 10084494 THEADORE  STUCKER CAMPION 01 1 19831202 360001592
13103 55 10085141 MAEGAN  BRUIN ANGLESEY 01 2 19541021 18900809
[ 143 13103 s 10071018 MAEGAN ~ AEBERSOLD A O 2 19541021 257005098
15102 5 10017276 ROSEANN  THUESEN s o 2 19151215 370005577
[ 158 15 102 s 10033266 ROSEANN  SEYBERT SUSIE 0 2 19400207 30005577
15101 57 10052829 MECHELLE LARRABEE  LYDIA 0 2 19311016 718002867 =
[ 159 150 &7 10057524 MECHELLE ~ FOISSET L 0 2 19740304 718002675
14100 58 9000053 SABINA  HOWLEY RASCHKE 01 2 19631215 284D03764
[119.4 14100 55 90000637 SABINA  HOWLEY RASCHKE 01 2 19431215 219517111
5 99 59 9000035 REGIS WADLINGTON  Z 0 1 19250215 919008707
L1212 5 99 5 9000063 REGIS WELLINGTON 7 0 1 19250315 919008707
0 %8 B 90000591 ALLSON  SAMUELSON LAUREL 01 2 19780918 22500903
0 220 098 60 90000GS7 ALLSON  SAMUEL-SON LAUREL 01 2 99999999 999999999
197 B e0000s30 ARON REDERICK O 1 19850207 242007504
[ 220 197 61 90000632 ARON REDERICK o1 19BE0207 111111111
0 % b2 90000SBI DAVINA  GANNAWAY LORENZA 01 2 19391120 258005679
022 0 9% 62 90000GES DAVINA  GANAWAY  LORENZA 01 2 19399999 999999999
3 9% B3 9000010 LINDSAY ~ STERNE 01 19370128 549001024
[l 242 3 95 B3 90000B12 LINDSAY  ROLLINS o1 19370128 549001024
7 94 B4 900DDSES SHERRON  STETLER DENSON 02 2 19930428 048003203
0272 7 84 B4 90000700 SHERON  STETLER DENSON 01 2 19930428 999999999
@3 b5 G0000E23 ALEXUS  STEWARD  ELIZA 0 2 19400210 935002465
L1272 1193 65 90000G2S ALEXUS  STEWARD  ELIZA 0 2 19400210 93502465
1@ BB 90000531 DARRON ~ DOWDELL  NOLAND 02 1 19520425 820007976
1290 1192 66 9000033 DARRON  DOWDELL  NOLAND 02 1 19520425 000000000
M8l 7 o0000s29 GINA MCELROYS  KEYS 02 2 19190410 914000955





Note that the three comparison pairs assigned the Set ID of 52 (Link IDs of 78, 105 and 106) have very different scores. The first pair, both with the name of OLA VALADE and a Social Security Number of 541003005 (Link ID of 78), has a very high score (34.1) and is definitely a duplicate record.  However, the next two pairs (Link IDs 105 and 106) vary on the Birth Date and Social Security Number, and do not match.

As a result, if you would like the Set ID to represent unique individuals, you will want to disassociate the Set IDs of the comparison pair with Link ID 78 from those of 105 and 106. First you will need to assign a match status to each of the comparison pairs, and then reassign the Set IDs.
To reassign Set IDs, complete these steps:

1. Assign a true match status to Link ID 78, and a false match status to Link IDs 105 and 106.
[image: image149.png][¥1= true matches. false matches || = uncertain matches = unmatched values = missing values
_|score |Class |Link ID | Set 1B | Patient ID Number | Name-First | Name--Last | Name--Middle |Race 1 |Sex | Birth Date | Social Security Numi|
4 78 &2 100377 OLA VALADE OTTILE O 2 19430105 541003006
[ 34.1 4 78 52 10033577 oA VALADE OTTILE 00 2 19439999 541003005
9 15 52 10053230 oLA VALADE 0 2 19540611 999999999
9 5 52 1003377 oLA VALADE OTTILE 01 2 19439999 541003005
9 B 52 1003377 oLA VALADE OTTILE O 2 19430105 541003005
9 B 52 10053230 oA VALADE 0 2 19540611 999999999
14 104 54 10054766 THEADORE  STUCKER € o1 19410314 022001023
[ 14.1 14104 54 10084494 THEADORE  STUCKER CAMPION 01 1 19831202 360001592
13103 55 10085141 MAEGAN  BRUIN ANGLESEY 01 2 19541021 18900809
[ 143 13103 s 10071018 MAEGAN ~ AEBERSOLD A O 2 19541021 257005098
15102 5 10017276 ROSEANN  THUESEN s o 2 19151215 370005577
[ 158 15 102 s 10033266 ROSEANN  SEYBERT SUSIE 0 2 19400207 30005577
15101 57 10052829 MECHELLE LARRABEE  LYDIA 0 2 19311016 718002867 =
[ 159 150 &7 10057524 MECHELLE ~ FOISSET L 0 2 19740304 718002675
14100 58 9000053 SABINA  HOWLEY RASCHKE 01 2 19631215 284D03764
[119.4 14100 55 90000637 SABINA  HOWLEY RASCHKE 01 2 19431215 219517111
5 99 59 9000035 REGIS WADLINGTON  Z 0 1 19250215 919008707
L1212 5 99 5 9000063 REGIS WELLINGTON 7 0 1 19250315 919008707
0 %8 B 90000591 ALLSON  SAMUELSON LAUREL 01 2 19780918 22500903
0 220 098 60 90000GS7 ALLSON  SAMUEL-SON LAUREL 01 2 99999999 999999999
197 B e0000s30 ARON REDERICK O 1 19850207 242007504
[ 220 197 61 90000632 ARON REDERICK o1 19BE0207 111111111
0 % b2 90000SBI DAVINA  GANNAWAY LORENZA 01 2 19391120 258005679
022 0 9% 62 90000GES DAVINA  GANAWAY  LORENZA 01 2 19399999 999999999
3 9% B3 9000010 LINDSAY ~ STERNE 01 19370128 549001024
[l 242 3 95 B3 90000B12 LINDSAY  ROLLINS o1 19370128 549001024
7 94 B4 900DDSES SHERRON  STETLER DENSON 02 2 19930428 048003203
0272 7 84 B4 90000700 SHERON  STETLER DENSON 01 2 19930428 999999999
1@ B5 o000 ALEXUS  STEWARD  ELIZA 0 2 19400210 935002465
L1272 1193 65 90000G2S ALEXUS  STEWARD  ELIZA 0 2 19400210 93502465
1@ BB 90000531 DARRON ~ DOWDELL  NOLAND 02 1 19520425 820007976
1290 1192 66 9000033 DARRON  DOWDELL  NOLAND 02 1 19520425 000000000
M8l 7 o0000s29 GINA MCELROYS  KEYS 02 2 19190410 914000955





2. Click on the Data menu item, and select the Reassign Set ID option.
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Result:  Set ID is automatically reassigned by individual comparison pair.

[image: image151.png]__|Score |Class |Link ID | Set I | Patient ID Number | Name~First | Name--Last |Name--Middle |Race 1 |Sex |Birth Date|Social Security Numi|

T 7 0 10033577 OLA VALADE OTTILE o 2 19430105 541003005
341 4 7 0 10033577 oA VALADE OTTILE il 2 19439999 541003005
9 5 1 10053230 oLA VALADE il 2 19540611 999999999
9 s 1 10033577 oA VALADE OTTILE i} 2 19439999 541003005
9 B 2 10033577 oLA VALADE OTTILE o 2 19430105 541003005
9 B 2 10053230 oLA VALADE o 2 19540611 999999999
[ 3 90000550 JAMARCUS  RUDACILLE I 02 1 19771113 178007027
[1432 1 3 90000650 JAMARCUS  RUDACILLE 7 02 1 19771113 178007027
102 4 90000600 BENITO DEVRIES W 02 1 19080801 000713616
Lll432 12 4 90000682 BENITO DEVRIES w 02 1 19080801 000713616
103 5 90000597 JAKOB BUSHONG B il 1 19411127 829005327
1§08 13 5 90000676 JAKOB BUSHONG B i} 1 19411127 829005327
14 6 90000598 WAYLAND  DOPSON 9 1 19000306 397008851
L1418 1 6 90000683 WAYLAND  DOPSON 98 1 19000306 397008851
105 7 90000538 FORREST  LANKFORD 97 1 19780105 736003244
[1417 15 7 90000638 FORREST  LANKFORD 97 1 19780105 736003244
108 8 90000572 NELLA SUTTEE EUNICE o 2 19720509 360000620
L1414 108 8 90000672 NELLA SUTTIE EUNICE o 2 19720509 360000620
[ 9 90000541 TRUDY ENDERS F il 2 19820127 000817188
[1414 17 9 90000641 TRUDY ENDERS F i} 2 19820127 000817188
108 10 90000555 MAY STILL. ROSEMARY 01 2 19530612 600000917
L1414 108 10 90000655 MAY STILL. ROSEMARY 01 2 19530612 600000917
19 11 90000575 MELONIE  PURPLE CHAVIS il 2 19571114 137003031
[1413 13 11 90000696 MELONIE  PURPLE CHAVIS i} 2 19571114 137008031
1 10 12 90000545 MARIA DEARDEN MARIORE 01 2 1926015 207005326
L1413 1 10 12 90000645 MARIA DEARDEN MARJORE 01 2 19260515 207005326
[T 13 90000567 FLOSSIE  CATCHINGS  NOEL il 2 19930303 359009629
[1413 1 13 90000667 FLOSSIE  CATCHINGS  NOEL i} 2 19930303 359009629
1 12 14 90000569 BEULAH  LANCON T o 2 19390814 907002128
L1413 1 12 14 90000669 BEULAH  LANCON T o 2 19390614 907002128
113 15 90000596 DANELA  DREES SUELLEN 01 2 19040301 152001975
[1413 1 13 15 90000884 DANIELA  DREES SUELLEN 01 2 19040301 152001975
1 14 16 90000BO1 CHAROLETTE LANDROTH W o 2 19360224 620008817




3. Scroll to the top of the list of comparison pairs, and view the pair assigned the Link ID of 78; it has now been assigned a unique Set ID of 0.

4. Scroll down the list of comparison pairs until you see the pairs assigned the Link IDs of 105 and 106; they have now been assigned unique Set IDs of 1 and 2.

Assigning Match Status - Review
As with manual review for external linkages, match status can be assigned manually within deduplication manual review by using the mouse to click in the Match Status check box, by using the keyboard, or can be assigned automatically by match score.
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To assign match status manually, for the comparison pair being reviewed place the cursor in the Match Status check box and:
· Left-click the mouse once, or press the “M” key to assign a true match status. 

· Left-click the mouse twice, or press the “N” key to assign a false match status.
· Left-click the mouse three times, or press the “B” key to assign an uncertain match status.
To assign match status automatically by score, click on the Data menu item, and select the Assign Match Status… option.

[image: image153]
Result:  The Assign Match Status dialog box opens.
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Enter any scores for which you would like to assign match status automatically, and click OK.
Independent Manual Review

Using the information you have learned today about the manual review process, configure the manual review screen to your liking, and experiment with the different options. Feel free to modify the screen layout as desired; re-order, re-size or hide columns, change the color scheme, or view the comparison pairs in Datasheet or Pair View. 
Take note of the comparison pair with Link ID of 65 to see an example of how the Link Plus First Name Matching Method links records with nicknames and full names. Take some time and resolve a few matches on your own, take a guess at approximate upper and lower cut off scores, and assign match statuses automatically by score.  Make sure to view the summary information at least once.  
Assigning Final Match Statuses

To assign the final match statuses for today’s deduplication linkage exercise automatically by score, complete these steps:

1. Click on the Data menu item, and select the Assign Match Status… option.
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Result:  The Assign Match Status dialog box opens.
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2. Click on Select true matches by score from, enter 21.1 in the first box, enter 100 in the second box, and then click OK.

Result:  The manual review screen re-opens with the specified match statuses assigned.

3. Click on the Data menu item again, and select Assign Match Status… a second time.
Result:  The Assign Match Status dialog box opens.
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4. Click on Select false matches by score from, enter 0 in the first box, enter 19.4 in the second box, and then click OK.

Result:  The manual review screen re-opens with the specified match statuses assigned.

Step 12:  Export Merged File

Once you have completed your manual review of the potential matches presented for review, and have assigned a match status to them (either manually by clicking, or via the Data…Assign Match Status option), you will want to export a merged file.  Link Plus offers the export of the merged file in a text file in delimited file format, and allows you to specify what file delimiter you would like to use, and what match status(es) you would like to export.

To set the export file options and export a merged file, complete these steps:

1. Click on the Tools menu item, and select Options…
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Result:  The Options dialog box opens, with the Manual Review tab selected.
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2. Click on the Export tab.

Result:  The Export Options dialog box opens.
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3. To set the export file format option to comma-delimited, click on Comma.
4. Unclick the Uncertain Match and False Match under Include, and then click the OK button.

Result:  The export file format has now been set to a comma-delimited file format, and when the data are exported, only duplicate records (those assigned a match status of true) will be exported.
5. To export the file, click on the Data menu item, and click on Export…
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Result:  The Export Setting dialog box opens.
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6. Select the fields from the data file that you would like in your merged export file by clicking the box in the column to the left of the data field.  Click the fields in the order in which you would like them listed in the export file.
7. Click on Export.

Result:  A window opens where you can specify a name for the exported merged file, and location on your computer or on a shared network folder where you would like to save the file. The default location for exported files within Link Plus is the C:/RegPlus/LinkPlus/Export folder.
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8. In the File name box, type Dedup1.txt, and click Save.

Result: A comma-delimited merged file (named Dedup1.txt) of records with true match status, with the data fields you selected (in the order that you specified) is generated and placed in the C:/RegPlus/LinkPlus/Export folder.  In addition, Notepad will open with a view of the merged file.
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9. Close out of Notepad and click Cancel on the Export Setting dialog box to return to the manual review screen.

10. Click on the Manual Review menu item, and select the Close View option.
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Result:  The main Link Plus window opens.
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Congratulations!
You have successfully completed today’s 
Link Plus linkage exercises.
Obtaining New Releases of Link Plus
You have been provided with version 2 of the Link Plus software for today’s training.  New versions of the software will be released in the future. 

To obtain any new release of Link Plus when it is available:

1. Go to NPCR Home Page:
http://www.cdc.gov/cancer/npcr
2. In the ‘Tools’ Section

· click on Registry Plus

3. Under ‘Registry Plus Components’

· click on Link Plus 

4. Under ‘On this page’

· click on Installing and Upgrading Link Plus  [image: image167.png]kplus\VbDemo\report\workingview. default]

LI =EIRRS
1 = true matches lse matches [] = uncertain matches = unmatched values = missing values,
Score |Class |Linkage ID | Set ID = |Record # | Patient ID Number |Name-First _|Name-Last _|Name-Middle |Race 1 |Sex |Birth Date| a
1 461 99098 90000600 BENTO  DEVRES W 02 1 13080601 El
[ 330 6 1 461 99180 90000682 BENTO  DEVRES W 02 1 19080601
2 460 99027 90000529 GINA MCELROYS ~ KEYS 02 2 19190410
[ 330 5 2 460 99129 90000631 GINA MCELROYS  KEYS 02 2 19190410
3 459 99043 90000550 JAMARCUS RUDACILLE ~ Z ©2 1 e
[ 328 6 3 459 99148 90000650 JAMARCUS RUDACILLE ~ Z ©2 1 e
4 458 99029 90000531 DARRON ~ DOWDELL ~ NOLAND 02 1 19520425
o327 5 4 458 99131 90000633 DARRON  DOWDELL  NOLAND 02 1 19520425
5 457 99043 90000545 MARIA DEARDEN ~ MARIORE 01 2 19260515
L1323 6 5 457 99143 90000645 MARIA DEARDEN ~ MARIORE 01 2 19260515
6 456 99095 90000598 WAYLAND  DOPSON 9 1 19000306
316 5 6 456 99181 90000683 WAYLAND  DOPSON 9 1 19000306
7 455 99095 90000597 JAKOB BUSHONG B o1 en2r
L1316 6 7 455 99174 90000676 JAKOB BUSHONG B o1 wn2r
8 454 99025 90000527 TYRONE ~ WINFREY ~ ETCHINSON 01 1 1927019
315 6 8 45499127 90000629 TYRONE  WINFREY  ETCHINSON 01 1 19270519
9 453 99036 90000538 FORREST  LANKFORD o 1 19780105
L1314 6 9 453 99136 90000638 FORREST  LANKFORD o 1 19780105
10 452 99082 90000584 ESTER HIPP MAGDALENA 01 2 19561005
314 5 10 452 99187 90000689 ESTER HIPP MAGDALENA 01 2 19561005
1 451 99018 90000520 ZELA WHITTINGTON SCHABLE 01 2 13220201
L1313 6 1 451 99120 90000622 ZELA WHITTINGTON SCHABLE 01 2 13220201
12 450 99067 90000569 BEULAH  LANCON T 01 2 19390614
313 5 12 450 99167 90000669 BEULAH  LANCON T 01 2 19390614
13 449 90000875 MELONE ~ PURPLE CHAVIS 0 2 9T
L1312 6 13 449 90000696 MELONE ~ PURPLE  CHAVIS 0 2 9T
i 448 90000572 NELLA SUTTIE EUNICE 01 2 19720509
312 5 1 448 90000672 NELLA SUTTIE EUNICE 01 2 19720509
15 447 90000517 ORAL HAWS NOONKESTEF 01 1 19930306
L1312 6 15 a7 90000619 ORAL HAWS NOONKESTEF 01 1 19930306
% 446 90000543 STACY MAYS BRITTEN 01 2 19630804
[ 311 5 16 445 90000643 STACY MAYS BRITTEN 01 2 19630804
7 415 20000526 NONOVAN  HUTGH 20 1wt
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